
 Chapter 5.

Reports, Letters and Labels

Alpha Five has awesome reporting capabilities.

The power of a database is the multitude of ways the data can be viewed. The same informa-
tion that confirms a sale can show a complete report of purchases by all customers.
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Overview

Another long chapter packed with information. As we did for the previous one, we’ve broken it down into segments.
Here’s a quick review of the topics and where you’ll find them when you need a refresher. Exercises are in “teaching
order,” so look around for what you need. New Version 10 features are in green.

Topic Page

Part 1. The basics of report design

     “Creating a Quick Report”  Sample reports; Preview: Toolbar description, Saving and emailing in other formats 
(PDF, HTML, etc.); Design toolbars and menus, Properties Pane.

181

     “Examining the report editor sections” Basic understanding of Report, Group and Detail sections. 192

    “Aligning and moving objects”  Moving groups, hiding sections, closing up space. 197

Part 2. Learning the report sections.

     “Customizing reports” 200

     “Modifying the Report Header” Cover page, calculated date field. 201

     “Modifying the Group Header”  IF function, Borders, Fonts. 204

     “Modifying the Detail Section”  Resizing and replacing fields, Numeric calculations, Overflow & blank pages, 
Sizing and formatting objects, Color alternate rows (greenbanding).

208

     “Modifying the Group Footer”  Group summary fields & labels, Manual and genie, Contitional criteria (boxes, 
fill color).

215

     “Modifying the Report Footer”  Grand total summaries. 220

     “Modifying the page footer”  Copy & paste from one report to another, Refine report. 223

Part 3. More report elements.

    “Enhancing reports”  Sub-reports, More about other formats (PDF, HTML, etc.), Watermarking. 225

     “Important things to know about reports”  Blank report, Properties, Regions, Pages, Columns, Add/ Remove 
Detail Section, Head/Foot; Filter & Order (see also letters); Printing, Importing layouts.

232

     “Creating Letters”  Using genie, more on filtering in all layouts. 240

     “Creating Labels and Envelopes” 245
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Preparation for the Lesson.
Open Alpha Five and navigate to the following file:

•c:\A5_Ver10Book\ABC_V10_Lessons\ABC Seminars.adb*

•  Click on the Control Panel tab in the Window Bar at the bot-
tom of the screen to bring the Control Panel to the front.

SPECIAL NOTES As fields are added to the form, the Summary Genie may pop–up. Accept the default
settings and click Finish.

The techniques in this chapter may be applied to any report. To do so, open the
report in design mode to begin the segment.

These exercises are designed to be done in book sequence. If you do the Operations
section before this Reports section, the report may not match the steps in the book
because some client names may have been deleted. To work around this problem, rein-
stall the companion files. They will overwrite any changes you have made.

Because this is a long chapter, it has been broken into a series of exercises. The quill
and inkwell mark the beginning and end of each exercise.

Learning Report basics

If you are new to Alpha Five, you may have already looked at the report editor and
might be feeling overwhelmed because its interface can look confusing at first glance.
Not to worry, we will take the sections one at a time. By the end of this chapter, you will

feel comfortable† and be ready to start your own design.

POWERFUL EDITOR The report editor is very powerful and you should not need an outside report writer.
Over the years, we have made very complicated reports. Before the Internet and online
data entry, we even copied government forms, line for line, so that we would not have to
complete them by hand.

Alpha Five presents a quick and easy way to get started with reports. We will first
design one using the genie and then we’ll update it with some custom design.

FINISHED REPORT Double click on FirstReportDemo to see a completed report for this segment.

Creating a Quick Report

Quick reports mean a quick start. In this section, we will use the Quick Report genie
to examine the design tools and learn how to use them. The next three pages illustrate
the genie and initial draft at design and preview modes, followed by a look at the final
custom report. 

*. Depending on how Alpha Five is opened, the file extension .adb may not appear. (For instructions on opening an existing database, 
see “Opening an existing database” on page 14.)

†. Promise!
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• From this:

• To this in a few minutes:
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• To this in a few more clicks:*

*. There are actually 4 pages in this report because some of the data has overflowed onto another page, as when you print a spreadsheet 
that is too wide for the page. We’ll fix that and refine the report in this chapter.
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• To this with a bit more work.

00001 Get Outta DOS
Marriott Courtyard Fort Lauderdale Plantation
Date:10/18/2001

Reg ID Name Reg Date Paid Date No persons Rate Amt Pd Amt Due Balance Due

258.0000001 Anderson, Joan H 08/08/2001 2 129.00 258.00

0.0000006 Appleton-Smith, Betsy R 08/13/2001 08/21/2001 1 129.00 129.00 129.00

0.0000007 Bush, Susan H 08/06/2001 08/06/2001 2 129.00 258.00 258.00

0.0000003 Halton, Geoff M 08/11/2001 09/01/2001 2 149.95 299.90 299.90

129.0000004 Hendrickson, Mary G 08/23/2001 1 129.00 129.00

0.0000005 Steele, John 08/05/2001 08/13/2001 1 129.00 129.00 129.00

0.0000002 Thompson, Sally H 08/10/2001 08/14/2001 1 129.00 129.00 129.00

Total Registrations for: 00001 10
Amt Due for: 00001 1,331.90

Total Amt Pd for: 00001 944.90
387.00Balance due for: 00001

Group Summary

00002 Get Outta DOS
Marriott Courtyard Lincroft/Red Bank
Date:02/09/2002

Reg ID Name Reg Date Paid Date No persons Rate Amt Pd Amt Due Balance Due

0.0000016 Anderson, William H 01/20/2002 01/25/2002 1 169.00 169.00 169.00

169.0000022 Appleton-Smith, Betsy R 01/10/2002 01/10/2002 2 169.00 169.00 338.00

0.0000010 Gleason, Harry G 01/20/2002 01/20/2001 1 159.00 159.00 159.00

0.0000015 Gleason, Harry G 01/25/2002 01/25/2002 1 169.00 169.00 169.00

0.0000026 Gleason, Harry G 01/04/2002 01/04/2002 1 169.00 169.00 169.00

0.0000008 Hendrickson, Thomas M 01/02/2002 01/15/2002 2 159.00 318.00 318.00

0.0000009 Williams, John 01/11/2002 01/11/2002 1 159.00 159.00 159.00

Total Registrations for: 00002 9
Amt Due for: 00002 1,481.00

Total Amt Pd for: 00002 1,312.00
169.00Balance due for: 00002

Group Summary

00003 Get Outta DOS
Marriott Courtyard Galleria
Starts: 06/07/2002   Ends: 06/09/2002

Reg ID Name Reg Date Paid Date No persons Rate Amt Pd Amt Due Balance Due

676.0000024 Anderson, Joan H 04/12/2002 04/18/2002 5 169.00 169.00 845.00

0.0000019 Bush, Susan H 04/21/2002 04/30/2002 2 169.00 338.00 338.00

0.0000025 Campbell, Mary 05/08/2002 05/08/2002 2 169.00 338.00 338.00

0.0000013 Franklin, Andrew O 05/23/2002 05/23/2002 1 169.00 169.00 169.00

0.0000011 Frome, Alice G 05/21/2002 05/21/2002 2 199.00 398.00 398.00

0.0000020 Steele, John 05/25/2002 05/25/2002 1 199.00 199.00 199.00

0.0000012 Thompson, Sally H 04/15/2002 04/25/2002 1 169.00 169.00 169.00

199.0000017 Williams, John 05/20/2002 05/20/2002 2 199.00 199.00 398.00

Total Registrations for: 00003 16
Amt Due for: 00003 2,854.00

Total Amt Pd for: 00003 1,979.00
875.00Balance due for: 00003

Group Summary

RegistrationsGenieDemo 11/18/2009
Page 2 of 3
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TROUBLE SHOOTING I have also used the quick report when I having trouble getting the desired results in
a custom report. If you can’t do the basics here, your design probably needs rethinking.

1. Alpha Five Control Panel Tab: Reports.

2. Click the New button.

3. Data Source: registration_rept.set

4. Method: Choose Use Quick Report. (Click OK)

•The Quick Report definition dialog box opens (screen shot on page 182).

5. Set the following parameters:

•Title: MyRegistrations.

•Style: Groups with totals.

FIELDS 6. Click the Fields button (should be default).

7. Select fields: 

a. Registrations table: Double click or drag the following fields to add 
them to the Fields box on the right side:

b. Clients table: Double click the Last Name field to add it to the Fields 
box:

CHANGE FIELD ORDER The fields appear on the report in the order listed in the Fields box. We will change
the order of the fields so they will be more logical for this report.

8. Fields: 

a. Click Seminar ID, drag it up to the top of the list.

b. Move Clients->Last Name to the 3rd position

MOVE FIELD If you have trouble getting the field to the top, move it to 2nd place. Then move the
top field below it—like a Rubix cube!

REMOVE FIELD To remove a field from the Fields box, drag it off to the right, out of the box or click
it and press DELETE.

GROUPS 9. Click the Group button for the available groups.

10. Double click Seminar ID to place it in the Groups box.

ORDER 11. Click the Order button. 

12. Double Click Clients->Last Name to move it to the Sort fields box.

SUMMARY 13. Click the Summary button.

•The genie has filled in the fields—all numeric—that are eligible for a sum-
mary operation. We’ll accept them. Procedure to change is as follows:

a. Click in the Summary Operation box and then click the smart button.

b. Choose a summary from the pick list.

Registration ID Registration Date No Persons Amt Pd

Seminar ID Paid Date Rate
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OPTIONS 14. Click the Options button. Click the checkboxes as follows:

a. Titles: Bold.

b. Page: Page Number, Day/Date, Center Title.

15. Click OK.

•The Report Editor appears (see screen shot on page 182). We will explain in 
detail each of the sections, but first let’s make one quick change and then 
take a look at the report.

PROPERTIES PANE If you have done the section on forms, you will be totally familiar with the

new Version 10 feature, Properties Pane (aka Properties Dock Panel).*

•Reminder: If it’s not visible, go to Top Menu > Task List > Properties or 
click on the Properties tab at the upper left of the design window. 

IMPORTANT NOTE

We will make one change in the instructions, however. Since the genie cre-
ated this report, the object names are not identified in the same manner as they were in
Chapter 4. In the form, the company field automatically was given the same object
name as the field and the same happens when an individual field is dragged onto a
report. In other words, the object name for the Company field would be “company.” In
the Quick Report, however, it is given a generic name, such as field2 or field3. In this
chapter, we will use the field name rather than the object name to avoid any confusion.

• Next, we will change the name of the heading and its color.

16. Click on the large title in the report: MyRegistrations.

17. My Registrations text > Properties Pane:

FONT •Color: Red

MISC •Name: HeaderTitle

Testing the design of the report
As we moved back and forth between design and form view to check the results of

our forms, we will move back and forth between design and preview to check the con-
tent and design of the report. It will be even more important here, because we really
can’t see the report until it is previewed. So, your report BFF’s are the Print Preview and
Exit Preview buttons.

• In Design mode, press the Print Preview button. In Preview mode, click the Exit 
Preview button to return to Design mode. (Betcha already figured that out!)

WORD TO THE WISE Saving the form is not required when moving from Design to Preview. Alpha Five is
quite stable at preview, however, it is highly recommended that you get in the habit of
saving before changing modes. Report design uses a lot of Windows resources and the
program may hang at Preview if you have a lot of unsaved edits. (Just when you least
want it to happen!)

•You can also print without saving because Alpha Five will create a temporary 
file, but, for the above reasons, it is still a good idea to save first.

*. For information on using the Properties Pane, see “Using the views” on page 87 and “Using the Properties Pane” on page 100.
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18. CTRL + S to save as MyFirstReport.

19. Click the Print Preview button on the Reports Toolbar.

Understanding the preview tabs

PLEASE TAKE A MOMENT TO 
READ THIS

When you go to preview from the report editor, an additional tab is opened in the
window bar below the report.

• If the tabs are not showing, 
choose Top Menu > View > Win-
dow Bar to open that section of 
your screen.

NAVIGATION These tabs allow you to move quickly between design and preview. There are certain
notations, however.

IMPORTANT NOTE Any time you click Print Preview, another preview window is opened, but Alpha
Five needs to freshly render the report each time changes have been made. Follow this
procedure to be sure you are always viewing the current design.

PREVIEW TO DESIGN a. Click the  button on the toolbar.

DESIGN TO PREVIEW b. Make any changes and click the Print Preview button  to return.

UNSAVED EDITS •Saving is not required before previewing the 
report. If the report is has unsaved edits, the 
editor TAB will show an asterisk (red box).

SAVE EDITS To save changes to the report, you must click Exit Preview and then save the report.
Properly done the asterisk (above) will be gone when you return to preview.

Understanding the preview toolbar
This toolbar is used for navigating, printing* and viewing the report. It also gives a

wide range of options for saving and/or emailing reports in one of five formats common
to most computer systems. This means recipients do not need Alpha Five installed on
their computers to read your reports.

IMPORTANT NOTE As you preview this report, you will notice there is overflow onto a 2nd page, like a
spreadsheet that’s too wide. Don’t worry about that now. We will fix it later.

PAGES The first group of buttons are for viewing certain pages in the report.

•First page, Previous page, Go to <page number> (you can enter the desired 
page), Next page, Last page.

PRINT The next group is for printing the report.

•Print and Print Setup.

VIEW The next group gives options for viewing the report on screen.

*. You can also print directly from the Report Editor, but, in most cases, you will probably want to preview it first.
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•Zoom. There are two zoom settings, in and out. You may also zoom by mov-
ing the cursor onto the report. It changes to a magnifying glass. 

•Two pages: Shows 2 pages on the screen at one time. Zoom must be set to 
lesser magnification so there is room on the screen for both pages.

•Color: Toggles areas with color off/on.

YOUR REPORT BFF  The Exit Preview button returns to report design mode.

ACTIVATE CONTROL PANEL The next button takes you to the Alpha Five control panel.

Saving reports as PDF, HTML, Rich & Plain Text and 
Excel files 
For the most part, you will probably save and print your reports from within Alpha

Five. There are, however, five additional formats that can be used to save and/or send
reports. 

Alpha Five has built-in HTML and PDF drivers.* Rich Text (Word and WordPer-
fect), Excel, and plain text formats are also available. Our purpose at this time is to give
an overview of the features available. There is further discussion in “Creating Letters”
on page 240.

• Selections are made at the final two “multiple choice” buttons.

•The one on the left saves the report in one of the above formats to a specified 
directory. 

•The second forms the report in the selected format and opens a Send Email 
form, with the report attached.

SAVE AS FORMATS 20. Click the drop down arrow next to the
left button (red box at left).

•When you hover over the down arrow, bubble 
help reads: Select format for saving report. 

•The icon on the button shows the last format 
used. (PDF is shown here, yours may be different.)

•Adobe Acrobat PDF. Most users have Adobe Acrobat Reader on their 
computers. It is also available as a free download at www.adobe.com. The 
PDF driver is built-into Alpha Five, so you do not need a separate program.

•Dynamic HTML File. Report will open in your browser. The HTML writer 
is built-into Alpha Five.

•Rich Text File. This can be read and edited by users of Microsoft Word and 
Corel WordPerfect.

•Plain Text File. Removes all formatting. Can be read by any computer 
user.

• Excel File: Report will open in Microsoft Excel, as a spreadsheet.

*. PDF driver rewritten in Version 10 for compatibility with Windows 7. See Help > What’s New in Version 10 > Desktop Features: 
New version of Alpha Five PDF Printer.
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The Save As dialog is the same for all the formats. 

a. Click the current button or its drop down arrow.

b. Choose the desired format (default is current button, but you 
can change).

c. Choose the directory.

The last used format remains the default. In other words, if
you format a report as a Rich Text file, the Word icon will appear
on the toolbar. It can, of course, be changed to a different format
at any time.

•Next, we’ll test out the PDF option. 

SAVE FIRST! If you have not saved the report, you will get an error message here advising you to
return to return design mode and save the report before you can continue.

21. Choose Adobe Acrobat PDF File.*

22. File name: Accept the default.

• C:\A5_Ver10Book\ABC_V10_Lessons\MyFirstReport.pdf

23. Open file with associated application? Check (Yes)

24. Click OK.

•The program may ask for permission to overwrite an existing file. (Yes)

•If it is unable to find a PDF driver, Alpha Five will ask for permission to try 
to install it. (Yes)

•If the PDF driver is installed correctly, the report appears on the screen. 

25. Close Acrobat. 

SEND EMAIL ATTACHMENT†

The process for sending email attachments is essentially the same as above,
except that the completed document is NOT shown on the screen.

In order to actually send an email, you will need to tell Alpha Five which
email client to use. For the purposes of this exercise, we will use your exist-
ing (default) email client, such as Outlook or Outlook Express. E-mailing
with Alpha Five is discussed in Bonus Pages: “E-mail and Fax with Alpha
Five”  beginning on page 521. We will also set it so that, once the email cli-
ent is defined, it will hold until changed.

a. Click the current button or its drop down arrow.

b. Choose the desired format from the Send As dialog.

*. This choice requires that Adobe Acrobat Reader be installed on your computer. You may get a free download at www.adobe.com. 
You may also choose another format if you prefer.

†. In the unlikely event that you have not set up an email account, you may be directed to go to the “Mail Icon on the Control Panel.” 
This means the WINDOWS CONTROL PANEL, not the Alpha Five Control Panel. Open the Windows Control Panel and click on 
Mail to set up the account. (This memo has been here since our earliest Alpha Five Made Easy book versions. Hard to believe 
there’s anyone out there without an email setup these days, but we leave it in just in case.)
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c. Click the Options button.

d. Choose Default e-mail client. 

e. Remember this selection: Yes. 
(Click OK)

f. Click Send.

•The report is formed and the send email win-
dow opens with the report attached.

26. Close the email window—or send
yourself a test email. And while you’re at
it, send me a copy! I’ll be sure to email you
back a congratulatory note for getting this

far!*

COLOR IT!
Note that these file types support color as well
as black and white type. That means you can
put your color logo on a report and email it to
your customer. 

27. Click Color.

•The red My Registrations title is changed to 
black.

28. Click Color again.

•The Registrations title is set back to red.

POST IT!
You can also post these files on your web site. 

•The PDF format works very well for this. Just put the link on your web page 
and store the actual file on the server.

•The HTML format opens in your browser. To see the underlying HTML, go 

to the browser Top Menu > View > Source (IE) or Page Source (Firefox).†

EXCEL NOTE When composing a report to be transferred to Excel, you will want to take that for-
mat into consideration. This report, for example, would require a fair amount of modify-
ing in Excel, because of the location of its total fields, among other things.

29. If possible, print a copy of the report, now. You will find the print–out
handy to use as a reference for the following exercises.

•Press CTRL + P or click the Print button on the Reports Toolbar.

30. Click the Editor TAB to return to Design mode.

*. My email address is susan@LibertyManuals.com. I’ve heard from lots of you over the years and I enjoy each one.

†. I’m no HTML expert, but I assume (dangerous, I know!) that you can copy and paste the code into your web page. -SHB


